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System Requirements 
• Microsoft Windows XP (SP1 or higher), 
• Windows 2000 (SP3 or higher with up to date security patches) 
• Microsoft Internet Explorer Version 6.0 or higher 
• 500 MHz Processor or faster 
• 256 MB RAM or higher; 
• OpenGL accelerated graphics card 
• Currently you must use the Microsoft Internet Explorer Web browser 6.0 or later. 

Other browsers such as FireFox or Netscape might be supported in the future. 
• ActiveX must be activated in the browser. 
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Installation 

To obtain the TruView Plugin... 
1. Visit the Leica website at http://www.leica-geosystems.com/hds/en/63727.asp. 
2. Register and download the plugin. 

To install or load the TruView Plugin... 
1. Double-click on TruViewSetup.exe or run it from the command line. 
2. Follow the instructions on the screen. 
Note: Internet Explorer 6.0 or later must be available for this plugin. 
Note: Be sure to restart your computer if asked to do so at the end of the installation. 
Otherwise TruView will not work properly. 

To allow TruView to work if the IE security system is blocking 
access... 
1. There is a yellow bar under the tool bars of Internet Explorer. Click it to allow ActiveX 
components to run. Then TruView will run. 
 
 
 
  





11 

TruView Site Map 
Each TruView scene is a panoramic (360 degree) image of point cloud data with the 
viewpoint being located at the same location as the scanner that captured the point 
clouds. Your viewpoint in TruView is from the exact scanner location that you chose. 
You can pan around the scene and zoom in and out, but cannot fly around the scene as in 
some 3D systems. Your viewpoint is always located at a scanner location. 
Often, a single project uses many scanner locations. In such cases, you can move from 
one scanner location to another to have various viewpoints within the project. Each 
viewpoint has a separate Scanworld. 
 

 
Site map - Two Scanner Locations (Viewpoints) 
   

The site map contains image icons  located at the center point of each available 
TruView scene. (The site map above has two scanner locations.) Click on a triangle icon 
and TruView launches inside Internet Explorer. 
NOTE: If Internet Explorer (IE) is not your default browser, then you must open IE first. 
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Entering a TruView Scene 
 
1. To enter a TruView scene, either visit a web page which is a site map, or go to an 
HTML document on your local drive, which has a TruView site map generated by the 
Cyclone PUBLISHER. The filename of the site map on your local computer is 
SiteMap.htm. 
 
2. Open the web page or html document. 

3. The site map contains image icons  located at the center point of each available 
TruView scene. Click on a triangle icon and TruView launches inside Internet Explorer. 
NOTE: If Internet Explorer (IE) is not your default browser, then you must open IE first. 
 
4. You can begin panning, zooming, marking up and using all the other features of 
TruView. 
 
Following is an example of a TruView window: 
 

 
TruView Window – Example of Markup mode 
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Basic Concepts 
Leica TruView is very simple to use. After you understand the basic concepts you will 
find it is easy to view, markup and measure point cloud data. The main thing to 
understand about Leica TruView is that it has three basic working modes: Measure, 
Markup and View. 

Measure Mode 
In Measure mode, the Measure tab  and Measure Control 

 are highlighted. TruView always opens in the Measure mode. 
This mode lets you move your viewpoint in, out and around the scene so you can find and 
look at your exact area of interest. It also lets you measure between two points or get the 
coordinate information for a single point. However, this mode does not place those values 
as permanent markups. They disappear if you change modes. It only reports them to the 
properties table at the left of the screen. If you want to place a dimension markup, use 
Markup Mode. 

Markup Mode 
In Markup mode, the Markup tab  and Markup Control 

 are highlighted. 

This mode lets you place markups like rectangles or text. When you are in markup mode 
the view is frozen like a screen capture or snapshot. Markups are placed as a group 
together on a saved (frozen) view. You can have many saved views, each with its own 
group of markups and its own name. 

View Mode 

In View mode, the View tab  and View Control  are 
highlighted. 

View mode allows you to jump from view to view. When you go to each saved view you 
can see the markups for that view. If any of these markups have a hyperlink (a feature 
allowed in markup mode) then you can navigate to those links by clicking on the markup 
in this mode. 
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Switching Modes 
There are several ways to switch between the various modes. Sometimes the modes 
automatically switch to a new correct mode as you perform other actions. For example, 
clicking on a markup tool automatically switches you to the Markup Mode. 

TruView always starts with Measure Mode activated. The Measure tab is selected and the 

Measure icon  is highlighted. 

 
 

To Enter Measure Mode 
• Open TruView 

Or 

• Select the Measure Tab     
Or 

• Select the Pan\Zoom Mode Icon     
Or 

• Select either of the 3D Measurement Icons     
Or 

• Double click in a Markup view 
 

In Measure Mode you can pan and zoom as well as take measurements. The values of the 
length, and ΔX, ΔY and ΔZ components for a line between two selected points are 
displayed in the properties panel in the Markup tab. The X, Y and Z components for a 
selected point are displayed in the properties panel in the Markup tab. The color "red" 
highlights the current measurement. 

Measurements are retained until you switch to Markup or View mode. When you switch 
modes, all the measurements are deleted. (Distances between points and coordinate 
points are retained in Markup mode.) 
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To Enter Markup Mode 
• Select the Markup Tab     

Or 

• Select the Markup Mode Icon    
Or 

• Select any of the Markup Item Icons on the 2D Markups toolbar 

  
 
A selection of markup types is available in Markup mode. Markups are placed on a 2D 
frozen image. This image, along with its markups, is saved as a recallable view. 

To Enter View Mode 
• Select the View Tab     

Or 

• Select the View Mode Icon     
 

View Mode allows you to pan and zoom through the view. You can also move to a 
previously saved Markup view by clicking on the view name in the tab. 

Measure in Measure Mode versus Measure in Markup Mode 
The definition of Measure in the Measure Mode for TruView is not the same as a Markup 
Dimension. In Measure Mode, measuring is not a drafting or markup function. It is 
simply measuring the distance between two points or extracting the coordinate location of 
a single point. The measurement values are shown in the Measure Properties Panel. 
However, in Markup Mode measuring is a "permanent" Markup function. 
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Controls and Tools 

Using Zoom/Pan Controls 
In Measure mode you can Pan and Zoom. 

Panning 
Panning is the process of moving the direction you are looking. It is similar to turning 
your head. You can look up, down, left or right. There is more than one way to pan in 
TruView. 

Pan Using the Mouse 

By picking any point in the TruView display widow with the left mouse button and 
holding it down you can pan in any direction by dragging the mouse in that direction. 

A red arrow stretches from the location you picked on the screen to the current location 
of the mouse. The farther you drag from the point you picked, the faster the scene pans. 
The red arrow shows the direction and how fast (arrow length) you are panning. 

 
Panning Arrow 

Pan Using the Icon 

You can use the Pan Icon on the Controls Toolbar to pan the TruView scene.  

You can pick anywhere on the icon to pan in the desired direction. If you pick once, the 
scene pans one small step. If you pick and hold, the scene begins to pan continuously 
until you release. For instance, picking in the upper right corner pans your view 
diagonally up to the right; picking on the right side of the icon pans to the right and so 
forth. 

Zooming 
Zooming is the process of moving towards or away from the direction you are looking. It 
is similar to moving your head closer to or further from a picture. There is more than one 
way to zoom in TruView. 

Zoom Using the Mouse 
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With a wheel mouse, pick any point in the TruView display window by depressing and 
holding the wheel and move the mouse down the screen to zoom in and up the screen to 
zoom out. 

Zoom Using the Icon 

You can use the Zoom Icon on the Controls Toolbar to zoom the TruView scene.  

You can pick the icon to zoom in or out. If you pick once, the scene zooms one small 
step. If you pick and hold, the scene begins to zoom continuously until you release. 
Picking in the upper portion of the icon (+) zooms in and picking in the lower half (-) 
zooms out. 

 

Using 2D Markup Tools 
A selection of markup types are available in markup mode. 
 

 
2D Markups - Tools 
 
Markups are placed on a 2D frozen image. This image is saved as a recallable view. 

Continuous Command Looping 
After you enter and complete a markup command, it remains active so you can place 
several of the same types of markups in a row without having to reselect the icon. You 
can terminate the command by right clicking and selecting “deselect” from the menu, or 
by selecting a different command icon.  

The various markup types are: 

• Arrow Line. 
o Pick a point where you want the arrow head and drag the line to the length 

and position you want 
• Circle and Rectangle 

o Pick a point and drag in any direction to the size and shape you want 
• Text 

o Pick a point for the upper left point of the string and type in the text 
• Coordinate 

o Pick a point for which you want the coordinate value then pick a point 
where to place the coordinate text. A rubber banding leader line is 
attached from the pick point to the location of the text placement 

• Distance 
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o You are prompted to select a first and second point. You then place the 
distance text label at the desired location with a rubber banding line 
attached. 

 
Note: If the scanner data has image data included for areas that were not scanned, such 
as the sky, then there are not any points you can measure to in those areas. Therefore, the 
system automatically darkens the non-measurable points so you can see the points that 
are measurable. This could be the entire sky or even stripes of data right in the main 
areas you wish to dimension. This depends on the density of the scanning and the 
scanning methods used to collect the data. 

Editing Markups 
You can edit any markup by first selecting it in the view area. “Handles” appear when a 
markup is loaded. You can also select the markup in the list of markups on the Markup 
Tab. 

• Arrow Lines, Rectangles and Circles can have their location and size changed. 
You can also adjust the properties. 

• Text can be moved, the properties can be changed, and you can edit the text string 
by right clicking on the text item in the view area and selecting Edit Markup from 
the right click menu. The cursor is placed at the end of the string, and you can 
only delete characters, add characters, and backspace. 

• Dimension labels (Coordinate and Distance) can have only the location of the text 
label moved. You can also change the properties. 

Deleting Markups 
Select the markup in the display area or in the markup tab list and press the delete key, or 
select the markup in the display area and right click and select delete from the pop up 
menu. 

Adding Hyperlinks to Markups 
Select any markup while in markup mode and enter any valid link value in the Link: field 
of the markup tab. This can be a web URL such as www.hds.leica-geosystems.com or a 
file location on disk such as c:\temp\temp.txt. 

The link value does not appear in the scene. To activate the link, you must go to the View 
Mode and double click on the object with the link. 

Markup Properties 
When any markup is selected you can set the properties for this entity on the markup tab. 
Different markup types have different markup properties that apply. For instance, an 
Arrow Line does not have any valid Font Size property. 

The available properties are: 

Unit: The unit of measure for dimension labels 

Color: Main color for line work 
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Fill Color: Background fill color for Circle, Rectangle, Text and Dimension Label 
text. 

Transparency: A percentage where: zero = opaque and 100 = totally transparent 
(invisible) 

Line Thickness: A relative factor controlling thickness of main line work of all 
markups except text. 

Font Size: For all markups with string characters 

Link: any valid hyperlink location 

Markup Metadata 
When markups are created they retain some Metadata. You can see this data displayed in 
the markup tab. The Metadata retains the date the item was created and the Windows 
login user name that created the markup. 

Setting Defaults for Markups 
At anytime you can select the “Set As Default” button in the markup tab to save the 
current properties settings as the default properties to use for all new markups. This 
setting is saved for all TruView sessions on the current computer. 

To share these settings with other users see Sharing Settings and Markups. 

 

Measurements Tools 
 
Two measurement types are available in markup mode. 
 

 
Measurements - Tools 
 
XYZ icon - Click this icon and then click the point for which you want coordinates. 
 
Ruler icon - Click this icon and then click the points between which you want the 
distance. 
 
The color "red" highlights the current measure or the selected measurement. 

Measurements are retained until you switch to Markup or View mode. When you switch 
modes, all the measurements are deleted. (Distances between points and coordinate 
points are retained in Markup mode.) 
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Tabs 

Tabs 
This section discusses the fields in the three different tabs:  

• View - Selecting this tab puts you in View mode, which allows you to jump from 
view to view. When you go to each saved view you can see the markups for that 
view. If any of these markups have a hyperlink (a feature allowed in markup 
mode) then you can navigate to those links by clicking on the markup in this 
mode. 

• Markup - Selecting this tab puts you in Markup mode, which lets you place 
markups like rectangles or text. When you are in markup mode the view is frozen 
like a screen capture or snapshot. Markups are placed as a group together on a 
saved (frozen) view. You can have many saved views, each with its own group of 
markups and its own name. 

• Measure - Selecting this tab puts you in Measure mode, which lets you move your 
viewpoint in, out and around the scene so you can find and look at your exact area 
of interest. It also lets you measure between two points or get the coordinate 
information for a single point. However, this mode does not place those values as 
permanent markups. They disappear if you change modes. It only reports them to 
the properties table at the left of the screen. If you want to place a dimension 
markup, use Markup Mode. 

 

View Tab 
Selecting this tab puts you in View mode, which allows you to jump from view to view. 
When you go to each saved view you can see the markups for that view. If any of these 
markups have a hyperlink (a feature allowed in markup mode) then you can navigate to 
those links by clicking on the markup in this mode. 
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View Tab 

View Display 
List of available named views (e.g., View#100) 
Clicking on a view displays that view. 

View Properties 
Created: - Date when this view was created.  
User: - Name of the person who created this view.  
Name: - Name of the currently selected view. 
Delete button - Click to delete the selected view. 
Update button - Click to rename the displayed view. 

Markup Data 
Client side marks: or Server side marks: Indicates the location of the currently 
loaded markup files, e.g., markup.xml. 
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Import : Click to import markups in an XML file, sent to you by someone, into 
your current TruView session. See Importing Markups for details. 
Export : Click to create an XML file of your current markups to send to  someone. 
See Exporting Markups for details. 
Load from Server : Click to load the markup.xml stored on a server, other central 
location, or the Web, which contains markups that you want to load in your current 
view.  

1. TruView displays a dialog to confirm that you want to overwrite the 
existing views and markups.  
2. TruView clears all existing views and markups. 
3. TruView searches markup.xml in the same place where you put the 
Scanworld’s published data. If this file does not exist, then nothing will be 
loaded. Otherwise, it will load the saved views and markups from the file. 

(The markups from the server overwrite the current markups. You must export the 
current markups if you want to save them.) See Exporting Markups for details. 
Load Local : Click to load (UID).xml from your local machine. This file is created 
automatically when you close TruView.(The last auto-saved markups overwrite the 
current markups. You must export the current markups if you want to save them.) 
See Exporting Markups for details. 
Clear All : Click to clear the scene of all markups. See Clear All Markups for 
details. 
 

Note: Server refers to the TruView directory on the local PC or on the intranet or 
internet.  
Note: Client refers to C:\Documents and Settings\(User Name)\Local 
Settings\Application Data\TruView\(UID).xml 
 
For sharing markup data, see "Sharing Settings and Markups". 

Utility 
Print: Click to print the current view. 

Markup Tab 
Selecting this tab puts you in Markup mode, which lets you place markups like rectangles 
or text. When you are in markup mode the view is frozen like a screen capture or 
snapshot. Markups are placed as a group together on a saved (frozen) view. You can have 
many saved views, each with its own group of markups and its own name. 
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Markup Display 
Current named view (e.g., <   View#100   >) 
List of drawing objects (Line, Circle, Rectangle, Position, Distance) in the current 
view. Clicking on an item in the list highlights that object in the view. 
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Markup Properties 
Created: Date when a specific markup was created. It is only displayed when a 
markup is selected. 
User: Name of the person who created a specific markup. It is only displayed when 
a markup is selected. 
Unit: Choice of meters, centimeters, feet and inches 
Color: Color chosen for lines, shapes and text 
Color palette button: Click this button to display a palette of colors. Choose a new 
color from this palette for lines, shapes and text. 
Fill Color: Color chosen for filling shapes. The actual fill color is the transparency 
percentage of this color. 
Fill Color palette button: Click this button to display a palette of colors. Choose a 
new color from this palette. The actual fill color is the transparency percentage of 
this color. 
Transparency (%): This value determines the shade of the fill color. (A 
percentage where: zero = opaque and 100 = totally transparent (invisible).) 
Line Thickness: The thickness of the line in points 
Font Size: The size of the type in points 
Link: Enter a URL to a selected markup. (You cannot jump to it from this tab. It is 
only activated for the View tab.) 
Delete button: Click to delete a selected markup (line, text, shape, coordinate, etc.) 
Reset button: Click to reset the properties of the markups to their original default 
values. 
Set As Default button: Saves the chosen settings for future use in this mode. 

Markup Data 
Client side marks: or Server side marks: Indicates the location of the currently 
loaded markup files, e.g., markup.xml. 
Import : Click to import markups in an XML file, sent to you by someone, into 
your current TruView session. See Importing Markups for details. 
Export : Click to create an XML file of your current markups to send to  someone. 
See Exporting Markups for details. 
Load from Server : Click to load the markup.xml stored on a server, other central 
location, or the Web, which contains markups that you want to load in your current 
view.  

1. TruView displays a dialog to confirm that you want to overwrite the 
existing views and markups.  
2. TruView clears all existing views and markups. 
3. TruView searches markup.xml in the same place where you put the 
Scanworld’s published data. If this file does not exist, then nothing will be 
loaded. Otherwise, it will load the saved views and markups from the file. 

(The markups from the server overwrite the current markups. You must export the 
current markups if you want to save them.) See Exporting Markups for details. 
Load Local : Click to load (UID).xml from your local machine. This file is created 
automatically when you close TruView.(The last auto-saved markups overwrite the 
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current markups. You must export the current markups if you want to save them.) 
See Exporting Markups for details. 
Clear All : Click to clear the scene of all markups. See Clear All Markups for 
details. 
 

Note: Server refers to the TruView directory on the local PC or on the intranet or 
internet.  
Note: Client refers to C:\Documents and Settings\(User Name)\Local 
Settings\Application Data\TruView\(GUID).xml 
 
For sharing markup data, see "Sharing Settings and Markups". 

Utility 
Print: Click to print the current view. 

Measure Tab 
Selecting this tab puts you in Measure mode, which lets you move your viewpoint in, out 
and around the scene so you can find and look at your exact area of interest. It also lets 
you measure between two points or get the coordinate information for a single point. 
However, this mode does not place those values as permanent markups. They disappear if 
you change modes. It only reports them in the properties table at the left of the screen. If 
you want to place a dimension markup, use Markup Mode. 
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Measure Tab with Point                     Measure Tab with Measure between 
Coordinates (Vertex) Chosen             Two Points (Distance) Chosen 

Measure Display 
List of Vertex and Distance objects in the current view. Clicking on an item in the 
list highlights the object and displays its values below. 

Measure Properties 
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Type: Distance (Distance between two selected points is displayed.): or  
Vertex (Coordinates of a point are displayed.) 
Color: Shows the color of the objects in the current view. 
Color Palette Button: Click this button to display a palette of colors. Choose a 
new color from this palette for lines and points in the current view. 
Unit: Select one of Centimeters, Meters, Inches, Feet 
Distance: Zero is displayed if a coordinate point (XYZ) is chosen.  

 Distance between two selected coordinate points is displayed. 
Δx: Distance in the x direction between two chosen points. 
Δy: Distance in the y direction between two chosen points. 
Δz: Distance in the z direction between two chosen points. 
x:   X coordinate of the chosen point. 
y:   Y coordinate of the chosen point. 
z:   Z coordinate of the chosen point. 
Set As Default button: Click this button to save the currently selected values for 
units and color. 

Markup Data 
Client side marks: or Server side marks: Indicates the location of the currently 
loaded markup files, e.g., markup.xml. 
Import : Click to import markups in an XML file, sent to you by someone, into 
your current TruView session. See Importing Markups for details. 
Export : Click to create an XML file of your current markups to send to  someone. 
See Exporting Markups for details. 
Load from Server : Click to load the markup.xml stored on a server, other central 
location, or the Web, which contains markups that you want to load in your current 
view.  

1. TruView displays a dialog to confirm that you want to overwrite the 
existing views and markups.  
2. TruView clears all existing views and markups. 
3. TruView searches markup.xml in the same place where you put the 
Scanworld’s published data. If this file does not exist, then nothing will be 
loaded. Otherwise, it will load the saved views and markups from the file. 

(The markups from the server overwrite the current markups. You must export the 
current markups if you want to save them.) See Exporting Markups for details. 
Load Local : Click to load (UID).xml from your local machine. This file is created 
automatically when you close TruView.(The last auto-saved markups overwrite the 
current markups. You must export the current markups if you want to save them.) 
See Exporting Markups for details. 
Clear All : Click to clear the scene of all markups. See Clear All Markups for 
details. 
 

Note: Server refers to the TruView directory on the local PC or on the intranet or 
internet.  
Note: Client refers to C:\Documents and Settings\(User Name)\Local 
Settings\Application Data\TruView\(GUID).xml 
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For sharing markup data, see "Sharing Settings and Markups". 

Utility 
Print: Click to print the current view. 
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Right Mouse Button Options - (Modes) 

View Mode 
Clicking on the Right mouse button, when in View mode gives you the following options: 

Markup - Clicking this changes the mode to Markup. 

Measure (Pan/Zoom) - Clicking this changes the mode to Measure. 

Print - Clicking this prints the current TruView display. 

Markup Mode 
Clicking on the Right mouse button, when in Markup mode gives you the following 
options: 

Rectangle - Clicking this allows you to draw a rectangle in the view. 

Circle - Clicking this allows you to draw an ellipse or circle in the view. 

Line - Clicking this allows you to draw a line in the view. 

Distance - Clicking this allows you to measure the distance between two points in 
the view. 

Position - Clicking this allows you to obtain the coordinates of a point that you 
select in the view. 

Unlock - Clicking this changes a 2D view to a 3D view. When in Markup Mode, 
you can return to Pan\Zoom Mode by selecting Unlock. 

View/Hyperlink - Clicking this changes the mode to View. 

Pan/Zoom - Clicking this changes the mode to Measure. 

Print - Clicking this prints the current TruView display. 

Measure Mode 
Clicking on the Right mouse button, when in Measure mode gives you the following 
options: 

Markup - Clicking this changes the mode to Markup. 

Print - Clicking this prints the current TruView display. 
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Metadata and Help 

Metadata Button 
Clicking on the Metadata button displays the Metadata screen. It contains information 
about the TruView scene that is open. Following is an example of a Metadata screen. 

 
Metadata Screen – Example 
 
UID – Unique ID for the scene. This is generated automatically and cannot be changed in 
TruView. 
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Background Dim – Dims the parts of the background for which a point cannot be 
picked, because it was not part of the Scanworld. This is always ON and cannot be turned 
off. 
Scan Meta – Data about the Scanworld 
Coordinate System – Coordinates of the scanner location for the Scanworld 
 
Panorama Meta – Shows the maximum error, point count within the display, and size 
for the given LOD value. 
View Defaults – Default values when the view is opened 
LOD Meta – Default values when the screen is opened 
Owner Info – Information about the publisher of the Scanworld 
 
Clicking the right mouse button and choosing “Export to Microsoft Excel” allows you to 
save the metadata to an Excel spreadsheet. 
Clicking the right mouse button and choosing “Print” allows you to print the metadata.  

Help Button 
Click on the Help button to display TruView Help and obtain information about the 
version of TruView that you are using. 
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Settings 
Several settings can be used to manage the display attributes of the markups in TruView. 
You can control: 

• Units of measure 
• Color (of all entities) 
• Fill color (of rectangles and circles) 
• Transparency (of fill color) 
• Line thickness (of circles, rectangles and arrow lines) 
• Font size (of text) 

You can change these values for each entity by selecting it for editing and changing the 
values in the markups panel. To set the current values as the default values, simply select 
the “Set As Default” button in the markups panel. 

Sharing Default Settings With Other Users  
If you have a set of default settings that you want to share with other users, then you need 
to find the defaults.xml file on your system and send a copy to them. After they place it in 
the correct location, they will inherit your default settings. This file (defaults.xml) is on 
your system at C:\Documents and Settings\(User Login Name)\Local Settings\Application 
Data\TruView. 
 
  





39 

FAQ / Troubleshooting 
 
Q: After clicking on the Scanworld triangle, I got the message: "Leica TruView 
Plug-In Not Loaded", but I had installed it. What is the problem? 
 
A: It is possible that Windows security is not allowing you to run ActiveX. If this is the 
cause, then there is a yellow bar under the tool bars of Internet Explorer.  

a. Click it to allow ActiveX components to run for this session of Internet Explorer. 
Then TruView will run. 
b. To permanently allow ActiveX to run, configure Internet Security to run by 
going to Start > Control Panel > Security Center > Internet Options > Security 
settings > ActiveX controls and plug-ins, and select Enable. 
c. You can adjust Internet Explorer to allow TruView ActiveX content to display 
on your computer by selecting the Tools > Internet Options… menu of Explorer, 
open the Advanced Tab and in the Security section add a check mark to the “Allow 
active content to run in files on My Computer”. 

  
Note: This problem can occur only if you are accessing a Scanworld on your local 
computer drive. 
 
Q: Why doesn't my TruView scene open when I click on a triangle icon in the scene? 
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A: This is probably because, either you are not using Internet Explorer, or you do not 
have ActiveX enabled. Internet Explorer 6.0 or later is required, and ActiveX must be 
enabled. Only Internet Explorer is supported at this time. 
 
 
Q: A link was entered in Markup mode, and the link is displayed when the object is 
selected. Why is there is no jump to the link? (The link target is not displayed.) 
 
A: Navigating to links is only active in View Mode. Otherwise there would be no way to 
select the item for editing in Markup Mode. 
 
 
Q: What is the meaning of the UID code (e.g., A47F0C8D-F9A3-4C45-9EEE-
1734DF60AF20)? 
 
A: The UID (Unique ID) code is an internal unique number that TruView uses to keep 
the markups paired to the right data sets. Each TruView panoramic scene is assigned a 
unique ID and the markup files also inherit this ID so they can be associated with the 
correct data set the next time you open things up.  
 
 
Q: What is LOD? 
 
A: LOD is the Level of Detail being displayed. It is proportional to the maximum point 
error. Zooming in or out changes the LOD that is displayed. 
 
 
Q: Why does the fill color rectangle not display the actual fill color?  
 
A: The fill color box is not affected by the current transparency settings. It displays the 
starting color, and the actual fill color is the transparency percentage of that color. 
 
 
Q: What is the default transparency? 
 
A: The initial system default transparency is 87%. You can change the default value 
when you save your defaults. 
 
 
Q: Why does part of the image darken when I try to select a coordinate value for a 
point? 
 
A: If the scanner data has image data included for areas that were not scanned, such as 
the sky, then there will not be any points you can measure to. Therefore, the system 
automatically darkens the non-measurable points so you can see the points that are 
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measurable. This could be the entire sky or even stripes of data right in the main areas 
you wish to dimension. This depends on the density of the scanning and the scanning 
methods used to collect the data. 
 
 
Q: In Markup View, I change the Unit setting from meters to feet, but the units in 
the view do not change. Why? 
 
A: The units are used only from the time they are set until they are changed. New 
markups use the new Unit setting (feet), but the old markups use the old Unit setting 
(meters). The Unit setting is not applied globally. 
 
 
Q: How do I change the units for an object? 
 
A: Click on the object. Then choose your new units from the Unit drop-down menu. The 
units will be changed for the object that you selected and for any new objects that you 
create. 
 
 
Q: If a markup object has a fill color, then clicking from Markup to View and back 
to Markup loses the fill color. It reverts to the previous fill color. Why? 
 
A: If you leave the Markup View, then when you return, the default values, including the 
fill color, are displayed. To keep the new fill color, save the values as the default. Then, 
the new fill color is the new default and is displayed when you return to Markup View. 
 
 
Q. My 3D Markup is not very accurate (repeatable), even though the precision is 
high. Why? 
 
A. The 3D Markup can not be very accurate unless the view is really zoomed in. Zoom in 
as much as possible.  
 
 
Q. How can I measure from a point in front of me to a point behind me? 
 
A. Pick the first point in front, then pan to the back and choose the second point.  
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